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APPEL A CONTRIBUTION : Si vous avez corrections, précisions ou ajouts à apporter, vous 
pouvez les écrire dans le fichier PDF à l’aide de l’outil « Notes » de Acrobat Reader, et 
mieux encore vous pouvez me les envoyer (le fichier, ou bien le texte si c’est assez long) 
pour que je complète le document.

Ma page sur Audiofanzine pour communiquer : http://fr.audiofanzine.com/membres/939970/ 

Il  reste  à  remplacer  les  références  aux  pages  des  manuels,  par  des  références  aux
paragraphes de ce document.
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Démarrage

Cet  aide mémoire ne prétend pas couvrir  exhaustivement  les fonctionnalités,  mais tente
d’offrir une approche pratique d’instrumentiste, contrairement à la liste de fonctionnalités du
mode d’emploi.

Cette version non terminée reste à compléter par le reste du manuel de l’utilisateur, voire par
des informations plus avancées au fur et à mesure de l’utilisation.

1 Démarrage

L’écran étant tactile,  chaque fois qu’on fait  mention d’une option écran à modifier,  il  faut
toucher le bouton ou l’icône de l’écran, puis modifier le cas échéant son paramétrage (avec
la molette ou les boutons DEC/INC).

1.1 OU trouver QUOI ? (A rédiger)..........................................................................................4

1.2 Connexion..............................................................................................................................5

1.3 Choix des sons.......................................................................................................................6

1.1 OU trouver QUOI ? (A rédiger)

Sujet
Paragraphe

Simple
Paragraphe

Avancé
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Connexion

1.2 Connexion

Au démarrage, en plus du câble d’alimentation, les connexions se font comme suit :

- 1. Interrupteur d’alimentation

- 2. Prise pour adaptateur secteur (bloc, secteur externe)

- 3. Crochet pour câble : pour bloquer le câble de l’adaptateur fourni.

- 4. « AUDIO OUTPUT » L/MONO, R

- 5. Prises Jack pour pédales : pour élargir les possibilités de contrôle d’effets et
de fonctions.

o DAMPER : pour  pédale  Sustain/maintien.  Si  la  pédale  n’et
pas de marque Korg, la polarité peut avoir besoin d’être réglée comme suit :

 bouton GLOBAL
 page P2 : Controller
 Option écran Damper Polarity 
 Modifier la polarité à l’aide des boutons DEC/INC ou de la molette

o ASSIGNABLE SWITCH : commutateur au pied
o ASSIGNABLE PEDAL : pédale d’expression

- 6. MIDI IN, MIDI OUT :

- 7. Fente pour carte SD

- 8. USB Host pour la connexion avec un ordinateur et le pilotage par un logiciel DAW

Pas de port USB ni de wifi.

KROME - Aide mémoire d’utilisation Mai 2016 5/40



Choix des sons

1.3 Choix des sons

1.3.1 Logique d’organisation des sons dans la mémoire (Programs et Combis)_____________________6
1.3.2 Sélection des sons (Programs ou Combis)______________________________________________7

1.3.1 Logique d’organisation des sons dans la mémoire (Programs et Combis)

1.3.1.1 BANKs de Program___________________________________________________________6
1.3.1.2 BANKs de Combinaisons______________________________________________________7

1.3.1.1 BANKs de Program

Un Program est un instrument ou une voix, socké dans les différentes Banques ci-dessous, 

BANK n° son Contenu Commentaires

5 banques A à E 0 à 127
Programs  
d’usine

640 Programmes d’usines (5x128), utilisant les 
multi-échantillons, effets, et arpégiateur interne.
ATTENTION : Ces banques sont modifiables

1 BANK F 0 à 127
Programs 
utilisateurs

128 programmes « initialisés » (libres) afin de servir 
à la création de sons ou au chargement de BANKs 
complètes (cf. le paragraphe correspondant)

1 BANK GM 1 à 128
Programs 
principaux GM2

256 programmes GM2. 
9 programmes de batterie compatibles Sound Map 
GM2 g(1) à g(9)
128 kits de batterie GM2 g(d) 
Ces banques ne sont pas modifiables, contrairement
aux 640 programmes d’usine.

g(1) à g(9) 1 à 128
Variations de 
Programs GM2

g(d) 1 à 128
kits de batterie 
GM2

Heureusement la sélection d’un son dans ces banques peut se faire selon d’autres critères
que la Bank, mais aussi par numéro ou catégorie d’instrument, comme montré sur la copie
d’écran ci-dessous.
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Choix des sons

1.3.1.2 BANKs de Combinaisons

Les combinaisons sont des sons complexes formés de plusieurs voix (superposition ou splits
de  Programs  avec  des  effets,  des  arpèges  et  une  partie  rythmique),  stockés  dans  les
banques ci-dessous.

BANK n° Contenu
4 BANKs A à C 0 à 127 512 Combinaisons chargées à l’usine (Preload)
BANK D 0 à 127 128 Combinaisons initialisées (libres)

Heureusement,  tout  comme les  programmes,  les  Combinaisons  ne  sont  pas  seulement
classées par Banques mais sont  aussi  réparties, comme montré sur la copie d’écran ci-
dessous,  en 16 catégories de 128 combinaisons chacune au maximum (BANKS A à D,
regroupant chacune 4 Catégories), la dernière Catégorie (USER 16) étant libre à disposition
de l’utilisateur. 

1.3.2 Sélection des sons (Programs ou Combis)

On  peut  accéder  au  BANKs  A à  F  (ou  A  à D pour  les  combis)  par  les  boutons
correspondants.

Par contre les BANKs au delà ne sont accessibles que par le menu écran (en cliquant sur
l’option écran > devant le nom de Program ou le nom de catégorie, ou en faisant défiler les
Programs ou Combinaisons à l’aide de la  molette ou des touches  DEC/INC après avoir
appuyé sur le dernier bouton de « BANK »).

Sélection par BANK :

- bouton PROG ou COMB
- bouton « BANK » A à F (ou A à D pour les combis)
- cliquer sur « > » à gauche du nom du son courant de la banque en cours
- la banque peut alors est encore changée par les onglets à l’écran
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Choix des sons

- cliquer sur le son choisi
- essayer le son
- option écran « OK »
- le son est disponible

Sélection par type de son :

- bouton PROG ou COMB
- cliquer sur « > » à gauche du type de son courant en haut de l’écran
- cliquer sur un onglet de type de son
- cliquer sur un son
- essayer le son
- option écran « OK »
- le son est disponible

Sélection par numéro de son :

- bouton PROG ou COMB
- taper un numéro sur le pavé numérique
- bouton ENTER
- le son est disponible

Sélection par défilement :

- bouton PROG ou COMB
- faire défiler les sons à l’aide de la molette à droite de l’écran, ou des boutons DEC et

INC situés au dessus.
- le son sélectionné est disponible
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Choix des sons

2 Utilisation avancée

2.1 Le panneau de commande___________________________________________________9

2.2 Les 5 Modes de fonctionnement______________________________________________13

2.3 Changement de son________________________________________________________16

2.4 Restaurer la configuration d’usine___________________________________________16

2.5 Chargement des Banques supplémentaires_____________________________________16

2.6 Mise à jour du firmware____________________________________________________17

2.1 Le panneau de commande

- 1. VOLUME

- 2. SW1, SW2 et Joystick :

o SW1  SW2 : boutons pour piloter divers paramètres de Programs ou
d’effets et d’activer/couper la fonction de verrouillage du joystick. (Voyez page
24)
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Le panneau de commande

o Joystick : Pour piloter des paramètres de Programs ou d’effets en
déplaçant le joystick vers le haut, le bas, la droite et la gauche. (Voyez page
24)

- 3. « REALTIME CONTROLS » : série de contrôleurs en temps réel de 4 potards
et 1 bouton pour effectuer les opérations suivantes:

o Piloter les sons et les effets des programmes ou combinaisons

o Piloter  l’arpégiateur :  Utilisez  le  bouton  SELECT pour  sélectionner  les
fonctions  pilotées  par  les  potards  1 à  4 ; modifier  le  son,  les  effets  et
l’arpégiateur.  (Pour  en  savoir  davantage,  voyez  “Commandes  REALTIME
CONTROLS” à la page 25.)

(voir “Editer des sons ou des effets avec les contrôleurs ‘Realtime Controls’” à
la page 28.)

- 4. ARP : bouton  pour  activer/couper  l’arpégiateur.  (Voyez  page
85)

- 5. DRUM TRACK : bouton pour activer/couper la fonction “Drum Track”. Ce
bouton  indique  aussi  l’état  de  cette  “piste  de  batterie”  (éteint=  fonction  coupée,
clignotant= en attente de déclenchement, allumé= fonction activée; voyez page 97.)

- 6. Section « EFFECTS »
MASTER FX, TOTAL FX : Boutons d’effets pour activer/couper les effets Master et
Total.
L’état  activé/coupé de ces boutons est  mémorisé même quand vous changez de
programme, de combinaison ou de morceau (voyez page 110).

- 7. Ecran tactile : (Voyez page 4)
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Le panneau de commande

- 8. Section « MODE »
GLOBAL, MEDIA à gauche de l’écran
COMBI, PROG, SEQ à droite de l’écran : 5  modes  de  fonctionnement.  Pour  en
savoir davantage, voyez “Sélection des modes” à la page 9.

- 9. BANK A, B, C, D, E, F : boutons  de  sélection  d’une  des  6
banques de Programs (A à  F), ou une des 4 banques de Combinations (A à  D).
Voyez page 21, et page 44.

Ces boutons permettent aussi de sélectionner :

o les banques de Programs pour Timbres au sein d’une Combination
o ou les banques de Programs pour morceaux au sein d’un morceau (voyez

page 46, et page 57).

Si vous voulez sélectionner une banque GM, utilisez les boutons du pavé numérique
(voyez page 22) ou le menu « Bank/Program Select » (voyez page 22).

- 10. Section « Controllers VALUE » : pour éditer le paramètre sélectionné à l’écran

o INC et DEC : Boutons pour avancer/reculer dans une liste
o VALUE : Molette pour avancer/reculer RAPIDEMENT dans une liste
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Le panneau de commande

o 0 à 9 : Boutons de pavé numériques
o – Bouton bascule signe négatif/positif
o . Bouton point décimal
o ENTER : Boutons pour  confirmer  le  réglage du paramètre sélectionné.

(Voyez page 10)
o COMPARE : Bouton pour comparer le son avant et après édition. Pour en

savoir davantage, voyez “Fonction ‘Compare’” à la page 11.

- 11. Section « PAGE SELECT » :

o PAGE : pour afficher la liste des pages du mode en cours. Appuyez sur
la page voulue. (Voyez page 9)

o EXIT : pour sélectionner des pages au sein du mode choisi.  (Voyez
page 9)

- 12. WRITE : Pour  sauvegarder  des  programmes,  des  combinaisons,  des
réglages globaux,  des kits de batterie ou des motifs d’arpège en mémoire interne
(voyez page 9).
Ce  bouton  permet  aussi  de  sauvegarder  des  morceaux  sur  support  de  mémoire
externe (voyez page 76).
Quand vous appuyez sur ce bouton à la page ou dans le mode requis, la fenêtre de
dialogue “Write” apparaît. Appuyez une fois de plus sur ce bouton pour sauvegarder
les données.

- 13.  Section  « SEQUENCER » :  En  mode  Sequencer,  pour  l’enregistrement  et  la
reproduction (voyez page 54). 

o || : PAUSE 
o ◄◄ : REW
o ►► : FF
o ▐◄ : LOCATE

o ● : REC permet aussi
- de sauvegarder un Program ou une Combination
- pour la fonction “Auto Song Setup” (voyez page 59).

o ►/■ : START/STOP

- 14. Section « TEMPO »
o TEMPO : Bouton pour règler le tempo de l’arpégiateur, de la piste

de batterie ou du séquenceur interne.

o Témoin TEMPO : Le  témoin  clignote  au  rythme  des  noires  du  tempo
choisi.

o TAP : Appuyer  en  rythme  sur  ce  bouton  pour  déterminer  le
tempo  de  l’arpégiateur,  de  la  piste  de  batterie  ou  du  séquenceur  interne
(voyez page 26).

- 15. Casque : Prise  casque  Vous  pouvez  y  brancher  un  casque.  Vous
obtiendrez le même signal audio qu’aux prises AUDIO OUTPUT L/MONO et R. La
commande VOLUME règle le volume du casque.
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Le panneau de commande

2.2 Les 5 Modes de fonctionnement

On accède à ces 5 modes à l’aide des 5 boutons correspondants, ou alors en cliquant sur
l’option écran qui affiche le mode courant dans le coin supérieur gauche de l’écran.

Chaque mode comprend plusieurs pages qu’on peut sélectionner après avoir appuyer sur le
bouton PAGE.

2.2.1 Mode PROG 12
2.2.2 Mode COMBI 12
2.2.3 Mode SEQ 12
2.2.4 Mode GLOBAL 14
2.2.5 Mode MEDIA 14

2.2.1 Mode PROG

Les programmes sont les sons de base de KROME. En mode programme, vous pouvez:

- Sélectionner et jouer des programmes.
- Utilisez un arpégiateur dans une performance.
- Lire des patterns de batterie pendant l’utilisation d’un programme.
- Modifier les programmes

Les  commandes  en  temps  réel  et  la  fonction  « Tone  Adjust »  permettent  de modifier
facilement le programme.

On peut éditer les paramètres et réglages des oscillateurs, filtres, amplificateurs, LDE, LFO,
effets, arpégiateur, piste de batterie, etc.

Jusqu'à 5 effets d'insertion, deux effets master et un effet total sont utilisables.

De plus, des programmes de batterie peuvent être créés en utilisant drumkits (comme en
mode Global).

2.2.2 Mode COMBI

Les combinaisons sont des ensembles de jusqu'à 16 programmes qui peuvent être joués
simultanément,  permettant  de  créer  des  sons  qui  sont  plus  complexes  qu'un  seul
programme. En mode Combination, vous pouvez:

- Sélectionner et jouer des combinaisons.
- Utilisez  plusieurs  timbres  pour  jouer  des  motifs  d'arpèges  générés  par  deux

arpégiateurs.
- Utilisez un ou plusieurs timbres pour lire les motifs de la piste de batterie.
- Utilisez le KROME comme un générateur de sons multitimbral 16 pistes.
- Modifier les combinaisons

Vous  pouvez  utiliser  la  fonction  « Tone  Adjust » de  régler  fonctionner  pour  modifier
facilement le programme de chaque timbre.
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Les 5 Modes de fonctionnement

Vous pouvez attribuer des programmes à chacun des 16 Timbres, chacun avec leur propres
volume, pan, EQ, ainsi que les zones et la vélocité du clavier;

Effectuer des réglages pour les effets, arpégiateur, piste de batterie.

De plus, utiliser jusqu'à 5 effets d'insertion, deux effets master et un effet total

2.2.3 Mode SEQ

Le mode Sequencer permet d'enregistrer, de lire et éditer des pistes MIDI. De plus on peut :

- Utilisez les 16 pistes séquenceur MIDI pour enregistrer et reproduire des morceaux. 
Enregistrer une seule piste MIDI à la fois, ou enregistrer simultanément autant de 
piste que voulu jusqu’à 16. Des messages exclusifs sont également enregistrables.

- Utiliser plusieurs pistes pour enregistrer et lire des performances générées par deux 
arpégiateurs.

- Utilisez une ou plusieurs pistes pour lire les motifs de la piste de batterie.
- Modifier des morceauxs.
- Utilisez le KROME comme un module de sons multi-timbral 16 parties.
- lecture GM / GM2 également pris en charge.
-  Utilisez la fonction « Tone Adjust » pour modifier facilement le programme de 

chaque piste.
- Utilisez jusqu'à 5 effets d'insertion, deux effets master et un effet total.
- Enregistrer des Patterns et les affecter à des touches individuelles, en utilisant RPPR

(Realtime Pattern Play / Recording).
- Créer une liste de Cue qui lit plusieurs chansons dans l'ordre voulu.
- Créer un Pattern Drum Track utilisateur.

2.2.3.1 Utiliser le séquenceur pour enregistrer une séquence________________________________13
2.2.3.2 Ajouter une autre piste à l’enregistrement________________________________________13
2.2.3.3 Utiliser un morceau de démo___________________________________________________14

2.2.3.1 Utiliser le séquenceur pour enregistrer une séquence

- Bouton mode PROG ou COMB
- Si besoin activer les boutons ARP et/ou DRUM TRACK (à gauche de l’écran)
- bouton ENTER en même temps que ● (REC)
- le bouton SEQ s’allume pour signaler le changement de mode
- bouton OK pour mettre l’enregistrement en stand by, ou bouton ● (REC)
- régler le tempo sur la base du clic du métronome
- bouton ►/■ (PLAY/STOP) pour démarrer l’enregistrement
- jouer à partir du moment ou le compteur en haut à gauche indique 1 (mesure) (le 

démarrage se fait à -2 mesures)
- bouton ►/■ (PLAY/STOP) pour stopper l’enregistrement
- bouton ►/■ (PLAY/STOP) pour écouter l’enregistrement

Les différentes pistes (16 au maximum) sont alors enregistrées comme suit :

- Track 1 : jeu au clavier en mode PROG ou COMB
- Tracks suivantes : autres pistes de jeu en mode COMB
- Track 10 : éventuelle piste DRUM TRACK
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Les 5 Modes de fonctionnement

NB :  le  nombre  de mesures  préalables  (2  par  défaut)  peut  être  modifié  dans le  champ
Precount Measure de la page P0 :Play/REC.

2.2.3.2 Ajouter une autre piste à l’enregistrement

Toujours en mode SEQ

- onglet « Preferences »
- décocher la case « Multi REC »
- onglet Prog 1-8
- toucher « > » en face de TRACK 01 pour sélectionner la première piste vide (par

exemple Track 02 : MIDI TRACK 02 si le premier enregistrement a été fait en mode
PROG).

2.2.3.3 Utiliser un morceau de démo

Seize  Modèles  de  morceau  (Template  Songs)  sont  disponibles.  Mais  en  configuration
d’usine ils ne contiennent qu’une partie rythmique et aucune partie musicale. La première
fois ou si les morceaux de démo ont été effacés (pour enregistrer ses propres morceaux), on
peut les restaurer à partir de la sauvegarde interne par la procédure décrite en page 27 du
manuel Quick Start. Le résultat et impressionnant (mais ne reflète pas uniquement les sons
du KRONOS car les morceaux contiennent des pistes audio).

La procédure pour les jouer se fait comme suit :

- Bouton mode SEQ
- page « 0:Play/REC »
- menu déroulant > Load Template Stong
- toucher « > » devant le nom de song pour choisir un style
- cocher si besoin « Copy Pattern to  MIDI Track too » pour copier un pattern en même

temps (??)
o option écran « OK »
o toucher « > » pour sélectionner un pattern
o toucher le champ Track pour modifier la piste avec DEC/INC ou la molette
o option écran « OK »
o ajouter si besoin d’pattern (par exemple pour intro, verse, chorus, bridge)
o option écran « EXIT »

- bouton Play/Stop pour démarrer la reproduction du song 
- bouton Play/Stop pour arrêter

2.2.4 Mode GLOBAL

Le  mode  Global  permet  de  régler  les  paramètres  globaux  pour  l'ensemble  KROME,  et
d’éditer kits de batterie, des Patterns d'arpèges. En mode Global, on peut :

- Réglez les paramètres qui affectent l'ensemble KROME, telles que Master Tune et le 
canal MIDI global.

- Créer des gammes utilisateur.
- Créer des kits de batterie utilisant échantillons de batterie.
- Créer des motifs d'arpèges utilisateur.
- Renommer des programmes et catégories de combinaison.
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Les 5 Modes de fonctionnement

- Réglez la fonction des pédales assignables et boutons assignables.
- Transmettre les DATA Dump de MIDI System Exclusive.

2.2.5 Mode MEDIA

On peut enregistrer ou charger des données en utilisant une carte SD. Le mode Media 
permet de :

- Enregistrer  et  charger les programmes, combinaisons,  chansons,  et  des données
globales de configuration.

- Formater une carte SD, copier et renommer des fichiers, etc.
- Effectuer des opérations de fichiers tels que la copie des données ou des médias.
- Exportater et importer des séquences vers et depuis SMF (Standard MIDI Files).
- Utilisez  la  fonction  « Data  Filer »  pour  enregistrer  ou  charger  des  données  MIDI

System Exclusive.

2.3 Changement de son

Voir le paragraphe « Démarrage » 1.3supra qui décrits les procédures de base pour changer
de son en mode Program ou Combinaison.

2.4 Restaurer la configuration d’usine

- bouton GLOBAL
- onglet « Basic »
- menu déroulant « Load Preload/Demo Data »
- menu déroulant “All (Preload PCG and Demo Songs)”
- option écran “OK”

En fait le menu déroulant offre 8 options de restauration :

- All (Preload PCG and Demo Songs)
- All Preload PCG :
- All Demo Songs :
- Programm :
- Combination :
- Drum Kit :
- Arpeggio Pattern
- Global Settings

En  cas  de  plantage  ou  d’instabilité  du  système,  la  manipulation  suivante  a  le  même
résultat que l’option « All (Preload PCG and Demo Songs) :

- éteindre le KROME
- maintenir enfoncer les boutons EXIT et PAGE
- allumer le KROME
- un message « Writing memory » doit indiquer que la réinitialisation a bien lieu

2.5 Chargement des Banques supplémentaires

KROME - Aide mémoire d’utilisation Mai 2016 16/40



Chargement des Banques supplémentaires

Le chargement d’une banque prendra la place des voix éventuellement déjà présentes dans
la  destination  qui  n’est  en  principe  pas  choisie  (du  moins  pour  les  2  banque  gratuites
fournies par Korg).

Le retour aux voix par défaut  est  heureusement simple,  comme expliqué au paragraphe
suivant.

Le site de téléchargement de Korg KROME contient 2 banques gratuites :

- celle issue du « M1 », une des premières workstations distribuées entre 1988 et 1996
(« sa  combinaison  de  d’échantillons  et  de  synthèse  numérique  donne  des  sons
puissants et plutôt réalistes », d’après wikipedia) : 

- celle issue du « TRITON », toujours distribué : 128 voix

NB : comme ces banques se chargent intégralement et automatiquement dans la BANK F,
les 2 Banques ne peuvent coexister à l’intérieur du KROME.

Le fichier zip contient également les instructions de chargement qui sont les suivantes :

- copier à la racine d’une carte SD (le KROME ne comporte pas de port pour les clefs 
USB), le contenu du dossier KROME_M1

- éteindre le KROME
- brancher la carte SD sur le KROME
- allumer le KROME
- a la fin du démarrage le KROME doit afficher un message de chargement de la 

banque
- attendre la fin du chargement
- bouton MEDIA
- onglet « LOAD »
- 1 ou 2 fichiers doivent s’afficher selon la banque : 

o 1 d’extension .PCG (KROME_M1.PCG par exemple)
o et  1  autre  éventuel  d’extension  .SNG  (KROME_M1.SNG,  alors  que

TRITON.SNG n’existe pas)
- sélectionner le fichier « .PCG »
- option écran « LOAD »
- cocher l’option écran « Load KROME_M14.SNG too » ou décocher l’option écran 

“Load TRITON.SNG too”
- option écran “Clear” pour “Select .SNG location”
- option écran “OK”
- un message indique le chargement de la banque
- continuer à utiliser le KROME normalement en changeant de mode par exemple

2.6 Mise à jour du firmware

2.6.1 Contrôler la version installée du firmware : 16
2.6.2 Installer le nouveau firmware 17

2.6.1 Contrôler la version installée du firmware     :

- Allumer le KROME
- Le numéro de version s’affiche brièvement en bas de l’écran
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2.6.2 Installer le nouveau firmware

Le fichier de mise à jour contient également les instructions. Pour la mise à jour de la version
1.03, les instructions sont les suivantes :

- Copier à la racine d’une carte SD (pas de port pour clef USB sur le KROME) les 6
fichiers contenus dans le dossier KROME extraits du fichier ZIP de mise à jour

- Connecter la carte SD
- Bouton GLOBAL
- Menu déroulant, option Update System Software
- Un message doit indiquer que la mise a jour s’est effectuée
- Eteindre le KRONOS
- rallumer le KRONOS
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3 Logiciels pour le contrôle du KROME

3.1 Applications PC 18

3.2 Edition par application iPad/iPhone 19

3.1 Applications PC

3.1.1 PCG Tools 18
3.1.2 Kromatool 18

3.1.1 PCG Tools

http://pcgtools.mkspace.nl/

PCG Tools is a free PC software application for Korg (c) Music workstations/synthesizers.
The application is capable of handling mainly PCG files. These files are used for programs,
combis and set lists, global information and more.

PCG Tools is mostly a librarian, but it also has some editor functions.

PCG Tools can be used for:

- Loading PCG files and navigating through the programs, combis, set list slots and
drum kits.

- Moving and sorting programs, combis and set list slots inside a PCG file.
- Copying  programs,  combis  and  set  list  slots  from  one  PCG  file  to  another  (not

converting).
- Edit names of programs, combis and set list slots.
- Opening PCG files of different models simultaneously.
- Creating all  kind of lists in text, CSV, XML or HTML format showing the usage of

banks, which programs are used by which combis or set list slots in various modes.
- Creating lists of duplicate programs, combis and set list slots.
- Creating patch lists for Cubase.
- Moving empty programs, combis and set list slots to the end, compacting the bank(s).
- For Kronos, editing the set list slot descriptions with use of Return characters (new

lines).
- Move timbres within a combi up or down.
- Check some basic content of SNG files.
- Lots more.

What can it NOT do?

- Converting programs or combis from one model to another.
- Editing all program or combi parameters.

 

3.1.2 Kromatool

http://kromeheaven.com/index.php/kromatool
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Applications PC

Application java (nécessite l’installation de java) dont le développement semble interrompu.

Pas de documentation

Compatibilité mac et PC mais, versions des OS non précisées.

- Dump de pack d’échantillons existants.
- Affichez entêtes et sections de Multisamples.
- Prévisualisation d’échantillons
- Extraction d’échantillons du fichier SAMPLE.IMG.
- créer packs d’échantillons.
- 2 modes: Batterie, instrument avec une boucle depuis le début.
- conversion KMP en META.IMG / SAMPLE.IMG.
- conversion KSC en META.IMG / SAMPLE.IMG

Tutoriels : 

- Korg Krome kromatool 0.7.0 : Merge 2 sample packs
- KROMATOOL 0.6.0 - KORG KROME SAMPLE TOOL
- Korg Krome Samples : Kromatool 0.5.0, KSC convert demonstration
- Korg Krome Samples KMP/KSF convert on Kromatool

3.2 Edition par application iPad/iPhone 

Plusieurs application Korg existent dans l’appStore (à un prix entre 18 et 27€), mais aucune
ne semble  dédiée  au  contrôle  des claviers  KROME ou KRONOS,  mais  sont  plutôt  des
émulations d’autres synthétiseurs Korg.

Ce n’est pas étonnant,  vu que le KROME, comme le KRONOS dispose déjà d’un grand
écran couleur tactile.
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4 Tutoriels

4.1 Vidéos 20

4.2 Textes (Textes en anglais à traduire) 20

4.1 Vidéos

Tuturiels vidéos en français également fournis sur le CD :

- Korg Krome Manual - Introduction 
- Korg Krome Manual - Mode Programmes
- Korg Krome Manual - Mode Combinaisons
- Korg Krome Manual - Mode Sequenceur
- Korg Krome Manual - Mode Global et Media

4.2 Textes (Textes en anglais à traduire)

4.2.1 Masterclass with Dan Stesco : Arpeggiators 1 20
4.2.2 How to get the calculator on your krome 23
4.2.3 How to import and modify midi files for the krome 23
4.2.4 Kromatool Sample preparation 26
4.2.5 How to select your custom samples to use them in programs 30
4.2.6 How to load sounds KRMpr...on your krome 33
4.2.7 Sounds Factory Reset (élucider différence avec § 2.3 ci-dessus) 36

4.2.1 Masterclass with Dan Stesco : Arpeggiators 1

4.2.1.1 Understanding Arpeggiator____________________________________________________20
4.2.1.2 Try yourself!_______________________________________________________________21
4.2.1.3 Other Velocity Trick_________________________________________________________22

4.2.1.1 Understanding Arpeggiator

Basic "the arpeggiators" is a function that automatically generate arpeggio. Being based on 
the polyphonic structure, they can generate a variety of phrase or chords transformation.

Fortunately, the Korg Voice Team has push to the limit the arpeggio exploitation and dual 
arpeggiators become close to a groove box.
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                                            Arpeggiator GUI on krome

Arpeggiators play notes on steps. The number of notes from a step depends on how many 
dots that are added on the step line and how many notes are playing on chords.

In this way, using one single arp pattern in combi mod, we can play two different timbre at 
the same time. (bass and guitar for example)

4.2.1.2 Try yourself!
 
Make a split, bass with guitar and run the arp pattern 666-Brs.Balcan Riff for timbre 1 and 2. 
The lower note from the chord will play the bass line and upper notes from the chord will play
the guitar chords.

Another important aspect : the arp pattern can cover a large area of keyboards using the 
octave ability.

Arp pattern under Krome Editor
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In the combi with multi split mod, the arp pattern can follow a scale with 4 or more 
consecutive timbre. Also, the octave ability can make arp pattern to come with delay.

For example if the timbre is limited by Key zone on the 4'th upper octave, the arp pattern with
1/16 time signature and 16 steps lenght which is selected to play 4 octaves will be active 
after 3 measures.

If the timbre is selected on lower zone the arp pattern will play once at 4 measures.

                Arp pattern Brs Balcan Riff but with acoustic bass and accordion !

The Arp Pattern can emulate the Wave Sequence:

Each step have velocity adjustment. So a timbre with fixed velocity can be played by the 
single step. 4 different steps can alternate 4 different timbre with same note.

4.2.1.3 Other Velocity Trick

In the same arp pattern we can hide two different loops for two different timbres.
For example two different bass pattern in the same arp.

Try to make the arp pattern with 16 steps. Use all steps for 1/16 bass pattern and set the 
velocity 100 for steps 2,4,6,8,10,12,14,16. Now set the velocity 110 for steps 
1,3,5,7,9,11,13,15. Make a combi with two bass split and separate by velocity; Timbre 1 
bottom 00 top 127 Timbre 2 bottom 110 top 127.
Playing the Timbre 1 range, the Pattern will be 1/16 notes and for Timbre 2 range the pattern
will be 1/8 notes.

So more tricks can be discovered using the unimaginable Arp possibility.
Making new attempts we can find a various application of arpeggiators. Is not a simple 
machine that only play a few notes.

Good luck,
Dan
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4.2.2 How to get the calculator on your krome

Author : Cyph

Did you know that you can access a simple calculator on your krome ?

Here is how to launch it :

On a program main page, just click on a real time parameter (TONE CONTROLS like Cut-
off), then click on calculate.

You will have the following windows :)

4.2.3 How to import and modify midi files for the krome

Author : Cyph

In this tutorial you will learn how to load and correct a midi file song that does not "sound"
properly.

In fact, the problem is that some midi files have "program changes" at the beginning of some
track that automatically select a non GM programs/patches (from bank A/B/C/D/E/F).

There are 4 steps to follow in order to correct the midi file.

Before  beginning  the  tutorial,  ensure  you  have  loaded  your  midi  file  in  your  Krome
sequencer. (MEDIA, LOAD, SELECT a *.mid file)

4.2.3.1 Step 1

GM Initialize  your  song,  sometimes,  it  is  enough to have your  song properly  set  to  GM
standard. It depends on the "program change" event your song has.

Press Play to check if you have only GM programs set at the beginning of your song : If not,
Go to STEP 2
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4.2.3.2 Step 2

Press PAGE button and go to the track Edit page by following this :
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Select the track you want to edit : Here TRACK 1...Then press the Track Edit Arrow to open
the menu.

4.2.3.3 Step 3

Here we will Edit the event of your track...Follow this :

Here, filter the event you want to display : We only want to check "program change", so
deselect others events.
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4.2.3.4 Step 4

Edit the program change event following this :

Put the G bank for a GM programs/sounds and g(d) for a drum track.

Go to the play menu and check !!!

Repeat this tutorial for all tracks (Go to Step 2 and select TRACK2, then TRACK 3...etc)

Enjoy !!!

ULTIMATE STEP :)

Save your song in the .SNG format and send it to us !!!

If I have enough song, I will create a dedicated section on kromeheaven !!!

4.2.4 Kromatool Sample preparation
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Author : Cyph

Hello,
in this article, I show you how to export its samples in the expected format to be used by the
Korg krome.

Kromatool can generate pack: META.IMG & SAMPLE.IMG only from the raw format.

To do this, I recommend using the Audacity software following this tutorial :

First, open your file in Audacity.
If it is a known format: File -> Open -> Select your file.
If it is an unknown format, you can try to use the import function ... Thus you can open a
samples krome file (SAMPLE.IMG file!) to check all samples contained in a pack.

After you open the file, we will remove some (Db) :

Select all the samples from your wavefom by double clickling on it.

Effects -> Amplify

and set a correct number of db. In my exemple i used -4,5 Db, in order to "lower" my sound.
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 This will prevent sound scratching.

(Normally,  you should  not  do this  step if  your  sound do not  exceed the half  of  the total
amplitude (see at the vertical -1 /+1)

Here is the result after decreasing Db :

Finally, you must export this sample in the correct format for the korg krome.

Go to the menu
File -> Export
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As in the following image.

In the "file selection" windows :

Click on the "options" button in order to verify the "export" format.

Choose "Raw header less"

Choose "Signed 8 bits PCM"

That's all folks !

Repeat this on each of the sample you want to have on your korg krome.

You can now go the kromatool software to generate your first sound package
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4.2.5 How to select your custom samples to use them in programs

Author : Cyph

Hello,
in this article, I show you how to export its samples in the expected format to be used by the
Korg krome.

Kromatool can generate pack: META.IMG & SAMPLE.IMG only from the raw format.

To do this, I recommend using the Audacity software following this tutorial :

First, open your file in Audacity.
If it is a known format: File -> Open -> Select your file.
If it is an unknown format, you can try to use the import function ... Thus you can open a
samples krome file (SAMPLE.IMG file!) to check all samples contained in a pack.

After you open the file, we will remove some (Db) :

Select all the samples from your wavefom by double clickling on it.

Effects -> Amplify

and set a correct number of db. In my exemple i used -4,5 Db, in order to "lower" my sound.
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 This will prevent sound scratching.

(Normally,  you should  not  do this  step if  your  sound do not  exceed the half  of  the total
amplitude (see at the vertical -1 /+1)

Here is the result after decreasing Db :

Finally, you must export this sample in the correct format for the korg krome.

Go to the menu
File -> Export
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As in the following image.

In the "file selection" windows :

Click on the "options" button in order to verify the "export" format.

Choose "Raw header less"

Choose "Signed 8 bits PCM"

That's all folks !

Repeat this on each of the sample you want to have on your korg krome.
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You can now go the kromatool software to generate your first sound package.

4.2.6 How to load sounds KRMpr...on your krome

Author : Cyph

Hello,
in this article, I show you how to export its samples in the expected format to be used by the
Korg krome.

Kromatool can generate pack: META.IMG & SAMPLE.IMG only from the raw format.

To do this, I recommend using the Audacity software following this tutorial :

 First, open your file in Audacity.
If it is a known format: File -> Open -> Select your file.
If it is an unknown format, you can try to use the import function ... Thus you can open a
samples krome file (SAMPLE.IMG file!) to check all samples contained in a pack.

After you open the file, we will remove some (Db) :

Select all the samples from your wavefom by double clickling on it.

Effects -> Amplify

and set a correct number of db. In my exemple i used -4,5 Db, in order to "lower" my sound.
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 This will prevent sound scratching.

(Normally,  you should  not  do this  step if  your  sound do not  exceed the half  of  the total
amplitude (see at the vertical -1 /+1)

Here is the result after decreasing Db :

Finally, you must export this sample in the correct format for the korg krome.

Go to the menu
File -> Export
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As in the following image.

In the "file selection" windows :

Click on the "options" button in order to verify the "export" format.

Choose "Raw header less"

Choose "Signed 8 bits PCM"

That's all folks !
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Repeat this on each of the sample you want to have on your korg krome.

You can now go the kromatool software to generate your first sound package.

4.2.7 Sounds Factory Reset (  élucider différence avec §     2.4  supra  )

http://www.kromeheaven.com/index.php/krome-stuff/tips/111-krome-factory-preset

Si  de  nouveaux  sons  on  été  installés  ou  modifiés,  le   "Factory  reset"  restitue  les
sons/programmes d’usine.

Pour ce faire, vous avez besoin de 2 choses:

1) éditeur Krome (livré pour votre PC ou votre MAC)

2) Le fichier preset de Korg Krome suivant : Télécharger Krome Factory Presets

Ensuite :

- lancer l'éditeur Krome:

- Cliquez  sur  "Utility",   "Load  ..."  puis  sélectionnez  le  fichier  « PRELOAD.KRMall »
téléchargé auparavant

- Cela restaure tous les sons originaux.

MAIS  ALORS  QUELLE  EST  LA  DIFFERENCE  AVEC  LE  FACTORY  RESTORE  DU
PARAGRAPHE 2.4supra ?
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5 Informations sur internet

Combi gratuites : http://kromeheaven.com/

Combis payantes : http://www.danstesco.ro/ 
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